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Overview

This User Manual contains an overview of the functionality in Orexplore Insight.

The contents are divided into following three main parts:

Introduction: Instructions on how to install the program and how to access the drill core

scan data as Holes and Projects.

Basic Features: Description of features that mainly allow the user to inspect results from

the drill core scan analysis.

Advanced Features: Description of features that allow the user to interactively extend,

annotate and export the already available results.

Quality Control: Description of features that allow the user to inspect data intended for

quality control, such as hardware conditions during scan and residuals associated with the

analysis results.

The screenshots below show the general structure of the program and its components:

Menu bar and tool bars

List of boreholes

• 

• 

• 

• 

1. 

2. 
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Depth scale

Tomographic preview of hole

Concentration plot view

Density plot view

3D tomography view

Concentration summaries

Render settings

Concentrations map

Additional widgets and toolboxes (not seen in the image) also include:

Core photo viewer

Intervals

Core logging

Attenuation segmentation

Stereonet plotting

Scan information

Quality control plot view

Export to CSV format

3. 

4. 

5. 

6. 

7. 

8. 

9. 

10. 

• 

• 

• 

• 

• 

• 

• 

• 
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Installation

Orexplore Insight is available for Microsoft Windows, Apple macOS and Linux. Below are

installation instructions for each of the platforms.

Example screenshots used within this manual have been produced with the Kubuntu flavor of

Ubuntu (Linux). The exact look of the program and its components may therefore vary,

depending on your choice of platform.

Microsoft Windows

Begin by launching the Windows Installer Package ( .msi ) file:

Note

1. 

https://kubuntu.org/
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The setup wizard will guide you through the installation procedure:

After the installation has finished, you'll find an Orexplore Insight shortcut on the desktop:

2. 

3. 
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Apple macOS

Begin by opening the Apple Disk Image ( .dmg ) file:

Complete the installation by dragging the Insight application to Applications :

1. 

2. 
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The application is now available under Go → Applications :
3. 
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Linux

Make the AppImage ( .AppImage ) file executable and then run it, through your file manager

or terminal program of choice:

The AppImage is a self-contained build of the program that should work on most Linux

distributions. For file association to the .insight  and .insight-project  filename

extensions (as described below) please refer to the documentation of your particular

desktop enviroment.

Starting the Application

There are three ways to start the application:

Double clicking the application shortcut: Insight will start up with an empty project

created.

1. 

2. 

• 
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Double clicking an Insight Project File ( .insight-project ): Insight will start up and load

the project. See Working with Projects for more information.

Double clicking an Insight Hole File ( .insight ): Insight will start, create a new project and

add the hole to the project. See Working with Holes for more information.

Entering a License File

Without a license file, the program is restricted to only opening example data available at 

Orexplore's website. If you are a customer of Orexplore, you will have been given a license file

which you need to enter.

If you are just evaluating Orexplore Insight using example data, you can skip this step.

To enter your license file:

Choose Help → Manage License... from the menu bar. A window will appear for managing

your license:

• 

• 

1. 

https://www.orexplore.com
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Choose Browse..., select your license file ( .json ) and click Open :

Information about the selected license will be displayed:

Status Valid indicates the license is valid, while Expired or Invalid would indicate a problem

with the license. Confirm the selection with OK and the application will start.

2. 

3. 
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A project allows to group together related Holes into a common workspace.

The project also holds user annotations and settings, such as

Bookmarks

Intervals

Attenuation Segmentation models

Structures

which allows the user input to be stored without modifying the original scan data.

Copies of your project files can also be used as a convenient and lightweight format to share

results with your colleagues and collaborators. Note that it may be neccessary to Locate a Hole

when using the new copy of the project.

Creating a New Project

Choose Project → New from the menu bar to create a new project:

Opening an Existing Project

Choose Project → Open... from the menu bar to open an existing project:

• 

• 

• 

• 

Tip
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You can also use the Open Project... button in the toolbar:

Saving a Project

Choose Project → Save from the menu bar to save the current project:

To rename a project use Project → Save As...:
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An Insight project contains a list of holes, each holding scan results from a particular borehole.

You can see the list of holes in the current project in the Holes list to the far left in the

application:

The active hole is indicated using bold text in the Holes list, and can be changed by double-

clicking any of the other available holes.

Like several other widgets in the program, the Holes list can be "folded" to save screenspace by

clicking the <  icon. To restore the widget to its original size and functionality, simply click the 

>  icon found on its folded representation.

Adding a Hole

Add a hole to the project by picking Hole → Add... from the menu bar or the Add Hole...

toolbar button.

Select the Insight Hole File ( .insight ) for the hole you wish to add, and confirm with 

Open.

The selected hole is added to the project and automatically opened.

Alternatively, a hole can also be added through a "drag and drop" action with the Insight Hole

File, from your file manager to the Holes list.

Tip

1. 

2. 
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Removing a Hole

Select the hole you wish to remove by single-clicking it in the Holes list.

Remove the selected hole by picking Hole → Remove from the menu bar. You can also

right-click the hole in the Holes list and pick Remove.

Removing a hole will also permanently erase all user data associated with it in the project (see 

Projects for details), both from the current session and from the project file when saved. Make

sure you really want to remove the hole before doing so.

Renaming a Hole

The name shown for the hole in the Holes list can be changed.

Select the hole you want to rename and pick Hole → Rename... from the menu bar. You can

also right-click the hole to rename and pick Rename.

Enter the new name and confirm with OK.

Locating a Hole

In case the location of the hole folder has changed since it was added to the project, you can

pick Hole → Locate... from the menu bar, and select its new location. The hole can then be

activated as normal, by double-clicking it in the list.

1. 

2. 

Caution

1. 

2. 
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The Depth Scale

The Depth view between the Holes list and Preview area marks the scanned depth, i.e. the drill

depth along the borehole axis entered during the sample scanning.

The depth scale is shared for the Preview and all of the plot views, which allows to visually

correlate the results.

To precisely track the depth across multiple views, a Depth indicator can be activated by picking 

Show → Depth Indicator from the menu bar:

The indicator tracks the current cursor position across all relevant areas, and writes out the

corresponding depth in the Depth scale area.

Tip
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The Preview

The Preview area between the Depth view and Concentrations plot shows the drill core

tomography for the active hole, and provides navigation along and around the drill core.

At low zoom levels, when more than 4 meters of core is visible, it will show a rough

approximation of the tomography:

At higher zoom levels, the actual 3D tomographic image of the core is shown, giving a more

detailed view of the core structure:

Panning and Rotating the Core

To pan and rotate the Preview:

Activate the pan and rotate tool from the toolbar:1. 
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Click and drag the mouse in the Preview area. Sideways motion rotates the core around its

axis while up and down motion pans the view to another depth.

You can also use the Up and Down arrow keys on the keyboard to pan the view up and down.

The Preview area must have been clicked at least once using the mouse for this to work.

Zooming In and Out

Use the mouse scroll wheel or two finger scrolling on your touch pad to zoom the Preview in

and out.

Navigating to a Specific Depth

To go to a specific depth in meters, pick Hole → Go to Depth... from the menu bar or press Ctrl

+ G on the keyboard:

Enter the depth and confirm with OK:

2. 
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The tomographic 3D image of the core is composed of 3D pixels ("voxels"), each representing

the X-ray attenuating power (attenuation) of the material at that point in space. The attenuation

depends on the density and mean atomic weight of the material. Higher density and higher

atomic weight both correspond to higher attenuation.

Materials rich in heavier elements, such as massive sulfides or galena, are more impenetrable

to X-rays and have a higher attenuation value, while lighter materials like quartz have a lower

attenuation value.

Compare this to medical X-ray imaging, where bone lets through less X-rays than the

surrounding soft tissue:

The left picture shows highly attenuating bone in a hand highlighted in white. To the right is the 

Preview area of Orexplore Insight showing a highly attenuating galena intercept highlighted in

red/orange, along with its corresponding increase in lead concentration and overall rock

density.

The 3D Tomography View

The tomographic Preview shows a low resolution down hole preview of the entire drill core. To

bring up a segment of core for closer inspection at full (200 μm per voxel) resolution, begin by

switching to the the 3D Tomography view:
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Selecting a Segment

To bring up a segment in the 3D Tomography view:

Pick the Select Segment tool from the toolbar:

Click and drag across the desired segment in the Preview area:

Upon releasing the mouse button, the selected segment is shown in the 3D Tomography

view. The blue selection highlight in the Preview area indicates the currently selected

segment.

1. 

2. 
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The amount of core that can be shown in the full resolution 3D Tomography view is restricted to

roughly 10 cm at a time. If while dragging, your selection exceeds this limit, the blue selection

highlight turns pale and the 3D Tomography will show the message Selection too large to

display. The segment concentration summary table will still be updated to reflect the selected

segment.

Controlling the Camera

The dip and direction of the camera in the 3D Tomography view can be controlled by dragging

the mouse inside the view with the left button held down. The view can also be zoomed using

either the scroll wheel, two finger scrolling or by dragging the mouse with the right button held

down.

Working with Bookmarks

If you have found a segment of core you wish to save and easily find your way back to, you can

add a bookmark:

Select the segment you wish to bookmark and pick Project → Add Bookmark... from the

menu bar:

Note

1. 
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Enter a name and optionally a description for the bookmark and confirm with OK :

Later, you can go back to the same spot by picking the bookmark under Project → Go to

Bookmark in the menu bar.

The bookmarks are saved as part of the project file; remember to always save your project, to

avoid losing your bookmarks.

Clipping

When viewing the full tomography, it may be the case that different parts of the volume overlap,

obstruct and/or obfuscate each other, in particular when dealing with massive phases that

render as nearly opaque.

Clipping allows to selectively hide parts of the volume, to better reveal others:

2. 

3. 

Caution
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Clipping is performed with a clipping plane, that separates the volume into a hidden and a

shown half. The clipping plane is enabled by clicking Show → Clipping in the menu bar:

The clipping plane is defined by a surface normal, which may be moved along the plane by

clicking and dragging its center point:
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The plane itself can be moved by clicking it and dragging it along the surface normal:

The plane and the surface normal may also be rotated into a preferred orientation, by clicking

and dragging the end point of the normal:
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Saving Images

To save the current segment of core as a PNG image, pick Hole → Save 3D Tomography View

to PNG... from the menu bar:

In the appearing window, choose some parameters for the image:
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When confirming using the Save button, you will be asked to provide an output file name. If you

just want to copy the image to the clipboard, click the Copy to Clipboard button instead.
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Adjusting the Render Settings

In the previous section, we saw how the Preview and 3D Tomography view can be used to

show the tomographic 3D image of the core. The color and opacity of the core rendering are

controlled by two functions, one that maps the attenuation of a voxel to a color, and another

that maps it to an opacity.

You can control these two functions through the Render Settings, which are accessible via 

Show → Render Settings in the menu bar:

The Render Settings view will appear:

There are two modes in which you can manipulate the color and opacity function, Quick Mode

and Detailed Mode, described in the sections below.



Skip to content

An alternative approach for adjusting the rendering of the tomography, suitable for advanced

users, is offered by the Attenuation Segmentation toolbox, which allows the user to define

regions of interest based on voxel attenuation histogram data.

Quick Mode

In the Quick Mode, which is the default, the currently used color and opacity function is shown

at the bottom:

The top X axis shows the attenuation scale and the Y dimension is the opacity. The color bar at

the bottom shows the color function.

The above settings would color lighter minerals like quartz in almost fully transparent black

(i.e. light gray), while heavier minerals like Barite would be colored in red. Very high attenuation

minerals like silver would be colored in yellow.

Below is an example segment of core colored using these settings. The core is made of mostly

lighter minerals (attenuation 0.5-2.0), with two main cross-cutting planar structures with

heavier mineral particles (attenuation 5.0-10.0).

Adjusting Color

In Quick Mode, there are two choices for the color function, either the gradual function from

black to red to yellow described above, which is called Gray Fire, or a fixed Black function. You

pick the color function using the Colors drop-down:

Tip
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Adjusting Opacity

To control the shape of the S-curve function that governs the opacity, use the Window / Level

input control:

By positioning the blue point in the white area, the shape of the S-curve opacity function can be

controlled. Vertical movement of the point controls the steepness of the S shape, while

sideways movement controls its extent across the attenuation scale.

For example, moving the point a little to the right, the S shape takes on a more elongated

shape, suppressing (making transparent) more of the lighter minerals and allowing us to focus

on the heavier components of the rock:

By default, the black, red and yellow points of the color function are positioned at attenuation 0,

10 and 20. By using the Keep Color Points under Window, they are instead placed equidistantly

under the S shape (the "Window"):
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Notice how the color gradient from black to red to yellow is now kept underneath the S shape,

the region of change for the opacity function. This option can be useful when you want to

quickly "tune" both the color and opacity function to some specific attenuation range. In this

case, from around 0.5 to around 8.0.

Detailed Mode

The default Quick mode is useful when you want to quickly adjust the color and opacity to

something reasonable for the segment of core you're currently looking at. If you want greater

control over the color and opacity functions, including the ability to save your settings as

named "presets", you can use the Detailed mode, available through a button at the top:



Skip to content

Creating Presets

In Detailed mode, there's initially just a single built-in color / opacity preset called Gray Fire. To

create a new one which you can edit:

Click the Duplicate preset button next to the presets drop-down to duplicate the Gray Fire

preset and use it as a starting point for your own:

You will be prompted to enter a name and description for the new preset:

Once the name is accepted with OK, the preset is created and the control points governing

the color and opacity function of the preset become visible:

Adjusting Color

Double-click a color control point in the color function (the bottom color bar). Doing so will

bring up a color selection window where you can choose the color for the point. Click and drag

a control point using the left mouse button held down to move it horizontally to a new position

along the attenuation scale.

1. 

2. 

3. 
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For example, using the preset created above, we can change the color of the red point to green

and move it to the left:

To insert a new point, click an empty spot along the color function. To remove a point, select it

by clicking it once, then press Delete.

The mouse cursor must be hovering the color function area when Delete is pressed, in order for

it to take effect.

Adjusting Opacity

Click and drag an opacity control point using the left mouse button held down to move it to a

new position along the attenuation / opacity scale. Insert a new point by clicking an empty

spot.

For example, to make the lighter material in our previous example more transparent and focus

on the heavier parts, we can insert a new low opacity point at around attenuation 4.0:

Note
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Remove an opacity point by clicking it once to select it and press Delete.

The mouse cursor must be hovering the opacity function area when Delete is pressed, in order

for it to take effect.

You can zoom in the Opacity and Color windows by changing the horizontal (X) and vertical (Y)

ranges. The horizontal and vertical ranges can be restored to show the whole function.

 

Importing and Exporting Presets

If you want to export a preset to a file, use the export button:

Note

Tip
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You will be prompted to pick a file name and location:

Confirm with Export and the file is exported. You can then share this file with your colleague,

who can import it using the import button:
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Element Concentrations

The GeoCore X10 geochemical analysis includes a mineralogical model fit of a user-provided

list of potentially present minerals to the observed XRF (X-Ray Fluorescence) and XRT (X-Ray

Transmission) signals. Depending on the contents of this mineral list, the fit may include

elements 1 to 92 (hydrogen to uranium), except for the noble gases and certain radioactive

elements.

Orexplore Insight only shows concentrations for elements detectable by the specific GeoCore

X10 model on which the scan was made. Current models can detect elements 13 to 92

(aluminium to uranium), excluding the following elements:

The noble gases: He, Ne, Ar, Kr, Xe and Rn (atomic numbers 2, 10, 18, 36, 54 and 86).

Certain radioactive elements: Tc, Pm, Po, Ar, Fr, Ra, Ac and Pa (atomic numbers 43, 61, 84,

85, 87, 88, 89 and 91).

Additionally:

Some older GeoCore X10 models can not detect Al, Si and P (atomic numbers 13, 14 and

15).

Au (atomic number 79) detections are only reported by Analysis Software Version 0.4.337

and on (see Scan Information).

If the XRF signal was degraded during scanning, element concentrations are not available

(see Degraded XRF Signals).

Element concentrations data is presented through several views in Insight, as described in the

following sections.

Concentrations Plot View

The element Concentrations plot can be found by picking Show → Concentrations from the

menu bar. Once enabled, the view is found to the right of the Preview and provides line plotting

of down hole element concentrations:

• 

• 

• 

• 

• 
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Plotting an Element

To plot the concentration of an element, right-click the plot view and pick the element in the

popup menu under Concentrations...:
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A new plot curve will appear, in this case a green one showing the concentration of iron:

The legend at the bottom of the view shows the current plot curve color assignments.

Adjusting the Scale

If the plotted element concentrations differ by orders of magnitude, it can be helpful to switch

to a logarithmic scale by picking Logarithmic Scale in the right-click popup menu:
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Concentrations Map

The Concentrations Map view, available under a tab next to the 3D Tomography view, provides

a gray scale intensity map showing the logarithmized concentration of all measured elements:

High concentrations are shown in black while low concentrations are light gray. Columns are

ordered by atomic number. Hover the map with the mouse pointer to inspect the concentration

at a specific spot. In this example, trace amounts of cadmium are picked out in a sphalerite ore

zone:
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The concentration map is useful as an overview of detected elements, and for identifying

geological facies and correlations between elements.

Concentration Summaries

To the far right in the program, a summary of mean concentrations are shown in table format:

The Hole table shows the mean concentrations across the current borehole while the Segment

table shows the mean concentrations for the currently selected core segment. The latter is

useful when comparing against lab assay data for a specific segment.

Sorting the Tables

The table can be sorted by clicking their headings, for example by concentrations:

For information on how to export the element concentrations to CSV (Comma Separated

Values), see Exporting Mass, Density and Concentrations.
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XRF Signal

As a complement to the results of the mineralogical fit (e.g. element concentrations), Insight

also offers the possibility to inspect the XRF signal that is part of the input, as a rawer form of

measurement variable.

The XRF Signal plot is enabled by picking Show → XRF Signal from the menu bar, and then

appears besides the Concentrations plot. As a companion to the Concentrations plot, the XRF

Signal plot uses the same popup menu and selection of shown elements:

The trends of the XRF Signal plot will typically bear a strong resemblance to the corresponding 

Concentrations, as an increased signal is often linked to an increased concentration. Yet, the

mapping from XRF signal to concentration is complex and not always monotonous. The XRF

signal may, for instance, be supressed or increased by the presence of other elements, or vary

through geometrical factors that depend on the position, shape and integrity of the scanned drill

core.

The XRF Signal is therefore by no means a substitute for the Concentrations, but rather a

complement offered for more detailed inspections.

Note
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The XRF Signal is presented on an undisclosed relative (unit less) scale, which is unique for

each available element, and subject to change without any form of notice. It should therefore

never be relied upon as e.g. a measure of element concentration, or be used for arithmetical

operations such as ratios between different elements.

Degraded XRF Signals

The standard sample holder used during GeoCore X10 scanning is a tube constructed out of

carbon fibre reinforced epoxy. The tube wall is densely perforated to permit largely

unobstructed XRF measurements of the drill core surface. The standard holder can be used for

the vast majority of drill core qualities.

In addition to drill core, the GeoCore X10 can scan unconsolidated materials, soils, chips and

heavily fractured/friable drill core. To permit scanning of these types of materials without it

escaping through the sample holder perforations or compacting during scanning, either a

special solid-walled sample holder must be used, or the material placed into smaller solid-

walled inner sample holders which are in turned placed in the standard sample holder.

Warning

Standard Sample Holder
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As XRF signals are inevitably obstructed for scans performed with solid-walled containers,

results for material scanned in anything but the standard sample holder are considered XRF

degraded. Results from the mineralogical model fit (element concentrations and high-

resolution estimated densities) and the XRF signal plot are unavailable for XRF degraded

sections, whereas the 3D tomography and per-sample measured density remains unaffected.

Solid Sample Holder Standard + Inner Sample Holder
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Rock Density

The GeoCore X10 analysis offers multiple rock density data sets, as can be found by picking 

Show → Density from the menu bar

which brings up the Density plot view:

The measured density (blue) is presented at sample resolution, with one data point per

scanned sample. These density values are based on the weight of the sample, as measured by

the load cell of the GeoCore X10 during scanning, divided by the rock volume calculated from
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the 3D tomography image. The estimated error in the measured density (including error

estimates both for the mass and the volume) is shown in the plot as a shaded region around

each measured density value

The estimated density (orange) is available in up to 8 mm resolution. These density values are

obtained from tabulated mineral densities combined with mineral mixture ratios from the

mineralogical fit (see Element Concentrations), divided by the rock volume calculated from the

3D tomography image. The average of the estimated density is additionally shown as a dashed

line for each sample, to facilitate comparison to the measured density.

The estimated density is only available for sections where the XRF signals are not degraded

(see Degraded XRF Signals).

Unlike the measured density, there is no direct error estimate of the estimated density, as it

depends strongly on the performance of the underlying mineral fit, which in turn depends on a

suitable choice of mineral list. The measured density (mass) is therefore employed as

reference for the estimated density (mass) in the Quality Control plot view.

For information on how to export densities to CSV, and information about the measured density

error estimate, see Exporting Mass, Density and Concentrations.

Older versions of the analysis software did not include the density data sets. The plot view may

therefore be empty when viewing scans that were analyzed prior to 1 April 2019.

Note

Note
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Tomographic Particle Data

The tomographic 3D images produced by the GeoCore X10 lend themselves well to detailed

inspection of core-interior properties, such as geological structures (see Logging Structures)

and particles embedded in the surrounding rock.

The example below shows both arsenopyrite (red) and pyrite-pyrrhotite (green) in a wall rock,

and coarse gold particles (yellow) in a quartz vein, as revealed by appropriate render settings

(Render Settings).
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Quantitative Particle Data

In addition to the 3D tomography itself, the GeoCore X10 analysis also produce quantitative

particle data sets, based on spatial segmentation of the tomographic data:

High attenuation particles (HAPs) are identified as connected regions in space, where all

voxels have an attenuation value equal to or higher than a chosen (high) attenuation

threshold. In the image seen above, the gold particles would be identified as HAPs for all of

the currently available threshold values (10, 12, 14, 16, 18 and 20 Al), as a voxel filled with

gold attenuates even higher.

Particle Size Distribution (PSD) Plot

An often sought particle property is the particle size distribution (PSD). A representation of this

is therefore available in Insight in the Particle Size Distribution Plot, enabled by Show → Particle

Size Distribution (PSD).

To combine the dimensions of drill depth, particle size, and histogram counts into a 2-

dimensional plot, the PSD is represented through a selection of percentile values (p25, p50, p75

and p100) calculated for the selection of particles contained in a depth range:

By right clicking inside the plot, a popup menu allows the user to select which combinations of

attenuation thresholds (for HAPs, see above) and percentiles to show:

• 
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The popmenu also allows to select between different Resolutions, where resolution refers to

the target length of depth ranges to accumulate particle statistics over:
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Core Photos

It is often helpful to compare the X-ray based scan data from the GeoCore X10 to the more

well-known content offered by traditional photos. Insight therefore offers the possibility to load

and show Core Photos, with automated coupling to the displayed depth range.

Showing Photos

To start viewing photos, open the Core Photos toolbox found in the menu bar:

The photos are now shown in a new window:

The window can be freely moved around and always stays on top of main window of the

program. This allows the user to chose which other areas to keep visible (or block) for

comparison to the photos.

Adjusting the Photo View

The zoom level of the photo view can be adjusted using either the scroll functionality of the

mouse or touchpad, or by pressing the +  or -  key with Core Photos as the active window.
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Once zoomed in on a part of the photo, the view can be panned ( up , down , left  and right )

by "dragging" the photo with the left mouse button, or by pressing any of the four arrow keys on

the keyboard with Core Photos as the active window.

The photo can also be rotated by clicking the Rotate photo  button, until the desired rotation is

achieved.



Skip to content

To easily adjust the window and its zoom level to a rough preference of size, the following steps

may often be useful:

Adjust the Core Photos window to the wanted size: 

Click the Fit photo to current window size  button: 

Click the Fit window to current photo size  button: 

Tip

1. 

2. 

3. 
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Automatic Photo Selection

The Core Photos window will per default change the displayed photo in accordance with depth

range changes in the Preview area.

The Photo Indicators, shown on the right side in the Preview area illustrates both where photos

are available, and which photo is currently displayed:

Alternatively, the user may opt to manually change the current photo by pressing the 

Show the next photo  or Show the previous photo  button in the lower right corner of the

window.

The automatic photo update may also be toggled on and off using the Auto  checkbox.

Customized Photo Files

If no photos were available at the time of the scan, or if an upgrade is in order, it is possible to

manually add / replace the photo files, by following these rules:

The photo files must be in one of the three following image formats: jpg  / jpeg , png  or 

tif  / tiff .

The photo files must be placed in a directory named core-photos , placed directly within

the Hole directory itself (e.g /HOLE01/core-photos ).

1. 

2. 
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The photo file names must be of the format A_X.x-Y.y.Z , where A  represents any

abitrary file name accepted by your desktop environment (e.g. MyHole-3_BoxPHOTO4 ), X.x

the start depth (e.g. 8.41 ), Y.y  the end depth (e.g. 102.1 ) and z  an applicable file

extension (e.g. png ).

While the Core Photos toolbox is primarily designed for the display of core tray photos, it is also

possible to display other types of data by adding the files in the same format. This includes, for

instance, zoomed in photos of smaller regions on a core, or even data plots produced from

alternative scanning techniques.

3. 

Tip
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It is a common use case to aggregate data over geologically interesting depth intervals. A user

may, for instance, wish to create a concentration export differenting between higher and lower

density regions of the core, rather than one line per 8 mm (default mode).

The Intervals feature in Insight allows the user to customize and define new intervals, in

addition to those that are automatically created.

The intervals are saved as part of the Project; remember to always save your project, to avoid

losing changes to the intervals.

To toggle this feature, pick Show → Intervals in the menu bar.

The Intervals side bar will now be visible to inside the Preview area:

Caution
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Boundaries are selected and manipulated inside this side bar. Boundaries are also shown

inside the Preview as horizontal lines, when sufficiently zoomed in. In order to not clutter the 

Preview, the lines are automatically hidden when zoomed out.

Selecting Intervals

An interval can be selected by left-clicking it in the Intervals side bar, which then sets its depth

range as the selected segment in the Preview.

It is also possible to select several intervals at once, by left-click dragging over all the intervals

that are to be included.

Initial Boundaries

Boundaries are initially inserted at the top and bottom of each sample (scanned section of

core).

The top-most boundary, the bottom-most boundary, and boundaries which represent

discontinuities in depth are immutable, which means that they can neither be removed nor

moved.

Note
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Adding a Boundary

New boundaries may be added by right-clicking while hovering a current interval. The clicked

interval is thereby subdivided into two smaller ones.

Removing a Boundary

An existing boundary can be removed by right-clicking it. The two intervals previously divided

by the point are thereby merged into a single larger one.

Notice the difference between removing a user-defined boundary, versus removing one of the

initial boundaries. When the latter type is removed, a light blue line is still seen inside the 

Preview :

Light blue lines thereby mark "special" positions, which allow to more easily restore the original

boundaries if needed.

Moving a Boundary

To move an existing boundary, click and drag it with the right mouse button ; other boundaries

can also be passed on the way.

Note that when two boundaries are moved on top of each other, they will be merged into a

single boundary.
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Conclusions drawn from drill core data are typically summarized as annotations associated

with particular depth ranges, i.e. as a Core Log.

The Core Log tool in Insight allows the user to define custom log categories (Lithology,

Alteration, Texture, Grade, ...) that each contain custom log values (e.g. "Lith code 1", "Lith code

2" or "Coarse grained", "medium", "fine"). Log entries are then created by associating user-

defined depth ranges with particular values.

When starting the program, the core log view is initially hidden. To show it, select Show → Core

Log from the menu bar

Core logs are saved as part of the Project; remember to always save your project, to not lose

any core log data.

Add Categories and Values

To start logging, the user must first define the categories and values that are to be logged. A

new category is added by clicking the addition button below the list of current categories and

selecting a unique name for it:

Note

Caution
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Once the category has been added, a corresponding column will appear, ready to house its

entries:

To add a value to an existing category, select the category from the list and click the addition

button below the list of current values:

Each value is defined both by a name (which must be unique within the category, but not to the

entire log) and a color with which it is graphically represented in its log column:
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Create Log Entries

When at least one value has been created, it is possible to start logging corresponding entries.

First select the category to log for, and the value within it that an entry should be made for:

Then press Ctrl (Cmd on Apple macOS) to start the insertion of a new entry:
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With Ctrl still pressed, then click on an appropriate position within the corresponding column

and drag the mouse over the depth range to be logged:

The entry is permanently created when the mouse button is released. Alternatively, the

insertion can be cancelled, by first letting go of the Ctrl key.

Adjust and Remove Log Entries

Previously logged entries can be adjusted both in terms of their depth range and associated

value.

To resize an existing entry, bring the mouse cursor close to its top or bottom. Once the mouse

cursor changes to indicate that resizing is possible, click and drag the boundary to adjust the

depth range that the entry spans:
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When resizing an entry, the mouse will automatically "snap" to nearby end points of other

entries, which prevents the accidental creation of small gaps between them.

When working with several different categories, "snapping" additionally occurs to entries in the

other categories, which simplifies consistent boundary alignment across the columns.

To change the value of an existing entry, first click the entry to select it (the currently selected

entry is indicated by a thicker, differently colored outline):

Then click the new value in the list of available ones:

Tip
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To remove a previously logged entry, simply press Delete or Backspace while the entry is

selected.

The current entry selection can be conveniently cleared by pressing the Ctrl (Cmd on Apple

macOS) key. It is recommended to do this directly after the adjustment of an entry is finished, to

avoid accidental adjustments with later input.

Both the creation and adjustment of entries may result in several entries merging into one, as

artifical boundaries between adjacent entries with the same value will be automatically

removed.

In the example below, two entries are automatically merged, as the value change of the upper

entry would otherwise result in an artifical boundary:

 

Edit Categories and Values

Both categories and values can at any point be edited to update their names (and associated

color). To do this, simply select the category or value from the list and click the corresponding

edit button:

Tip

Note
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To remove a category or value, click instead on the corresponding remove button:

 

Removing a value also permanently erases all entries associated with it, potentially erasing

large amounts of logged data. Removing a category in turn erases all values associated with it.

Always proceed with caution when confirming the removal of a value or category.

CSV Import

Already existing core log data can be imported for comparison, adjustment and extension in

Insight, from CSV (Comma Separated Values) format. To start the import, first click the Import

CSV button:

Warning



Skip to content

Then specify the data to import and its format in the Import CSV dialog. The data can be

provided either as a local file to be read, or by pasting in the raw text input:

Next, the user must select which columns of the CSV data to interpret as the start and end

depths of the intervals, and which columns to import as categories:

It may typically be the case that the imported core log data is not entirely contained in the

scanned depth range. The user is therefore notified if any intervals will be skipped from import:

Each selected column is then imported as a separate core log category, with unique entries

interpreted as new values and assigned default colors:

Note
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For information on how to export core log data to CSV, see Exporting Core Log.

Tip
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Skip to contentAttenuation Segmentation

The tomographic data produced by a scan contains vast amounts of information, that benefit

from specific tools designed to unpack it for interpretation.

The Attenuation Segmentation toolbox allows the user to inspect and interact with histogram

data of the voxel attenuation, to discover trends, mark out regions of interest, and visually

segment the tomography based on the constructed model.

The tool is found by picking Toolboxes → Attenuation Segmentation from the menu bar.

Histogram Data

When loading a hole, the Attenuation Segmentation toolbox initially displays a histogram

computed for the entire hole over a wide range of attenuation values:

To discern relevant features of the histogram, it is typically necessary to zoom in on a narrower

range of attenuation values, as controlled through the μ min and μ max boxes:



Skip to content

The user also controls which depth range the histogram data is to be accumulated over; the

current depth range values are shown in the Start and Stop boxes, which are updated based on

the currently set Depth control mode:

Preview (default): The depth range values automatically correspond to the entire visible

depth range in the Preview area.

Segment: The depth range values automatically correspond to the selected segment in the 

Preview area.

Manual: The depth range values remain unchanged, unless manually edited by the user.

Three different Histogram update modes are also available:

Auto (default): Histogram data will be automatically loaded whenever the depth range

values are changed.

Manual: Histogram data will be loaded when the user presses the Load histogram button.

Calculate: Histogram data will be recomputed directly from the tomographic data when the

user presses the Calculate histogram button.

The Manual mode is convenient when the user wants fixate the visualized histogram, while still

exploring different depths in the Preview and 3D Tomography areas.

• 

• 

• 

• 

• 

• 
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The Calculate mode is provided purely for compatibility with older scan data, which lacks

precomputed histogram data to load. This mode will be automatically selected if there is no

data to load and cannot be directly selected by the user:

The following information applies only for the Calculate mode.

The large size of the tomographic data makes the histogram calculation a computationally

demanding operation. Depending on the computational setup, it may very well be bottlenecked

by CPU power, available memory size and speed, and/or the speed of data access via network

or disk reading.

Always start by testing the calculation on a relatively short depth range (up to 0.1 or 0.2

meters), then be ready to patiently wait for the results when extending to longer ones.

Adding Regions

Based on the histogram data, it is likely that the user may want to mark particular regions of

interest (ROIs) along the attenuation axis. In the example above, there are three clearly

discernable features, each centered roughly at 1.0 Al, 1.25 Al and 1.55 Al. A different example

will be explored below, with three features spread over a wider attenuation range.

To define a new region, click the Add button, found to the bottom left, which will bring up a

dialog for setting the parameters of the region to be added:

Each region is defined by a rectangular function with the specified height, that stretches from

its μ min parameter to its μ max parameter.

Each region also has an associated color, opacity (see Coloring the Tomography below) and

label; the label allows the user to annotate any useful information regarding, for instance, why

Caution
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the region was added (e.g. "narrow sharp peak at high attenuation") or what it may represent

(e.g. "quartz vein").

When the parameters have been set, the region will be plotted out on top of the histogram:

Regions are saved as part of the Project; remember to always save your project, to not lose any

of the added data.

Adjusting Regions

Once added, regions can be edited either by double-clicking them in the table or by clicking the 

Edit  button when the region is selected.

Any number of regions may be removed by selecting them in the table and then clicking the 

Remove  button.

Caution
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If a more graphical approach is preferred over the numerical entering of parameters, it is also

possible to adjust the attenutation range of any region by selecting it and then dragging one of

the sliders marked as Start  or End :

If the Lock checkbox is checked, the two sliders will move in unison, effecively translating the

region along the attenuation axis.

By adding and adjusting a number of regions, all features of interest in the histogram can

eventually be marked out:

Coloring the Tomography

When one or several regions have been added, they may be used as an alternative approach for

coloring the tomography by clicking the Color button, found to the bottom right; this will

Tip
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calculate the opacity-weighted sum of each region's color, as a function of attenuation, to

produce color and opacity functions for the tomographic rendering.

The end result is a visual segmentation of the entire volume, based on the underlying

segmentation of the attenuation histogram:

If the Auto checkbox is checked, the Color action will be automatically applied whenever a

region is added, changed or removed.

Beware that frequent updates may prove demanding to render and therefore inadvisable on less

powerful computers.

While the Attenuation Segmentation toolbox is active, the regular Render Settings will be

disabled:

Tip



Skip to content

Clicking Inactivate  will close the Attenuation Segmentation toolbox and return the Render

Settings to its previous state.

The coloring produced with the Attenuation Segmentation toolbox can be saved for later reuse

by first clicking the Make preset  button, which allows to export the coloring as a regular 

Detailed Preset.

By combining the functionality of the Lock and Auto checkboxes, it is possible to practially

perform a "sweep" over the attenuation axis for interesting ranges:

By dragging the short-ranged but opaque red function over the attenuation axis, various parts of

the tomography will be selectively highlighted (as compared to the "background"), which

facilitates the search for e.g. familiar patterns.

Tip



Skip to content



Skip to content
Logging Structures

Insight has support for logging planar and linear structures, using the tomographic 3D image of

the core as a guide.

When starting the program, structures are initially hidden. Logged structures can be shown and

hidden using the Show → Structures check box in the menu bar.

The orientation of each logged structure is defined by a set of internal and (optionally) global

orientation angles. For more information on these angles, see Structure Orientations.

Structures are saved as part of the Project; remember to always save your project, to not lose

any annotated structures.

Adding Structures

Structure additions are initiated from the Structures Toolbar, which is shown in the top part of

the window when structures are shown (see above):

Note

Tip

Caution
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Two complementary modes are offered:

Clicking the Palette button brings up the Structure Palette floating window:

This mode is well suited for logging a wide selection of different structure types, as both

categories (linear and planar) and all corresponding types (e.g. "Fold Axis" and "Foliation")

are available through a single button click.

Selecting the category (linear or planar) and the corresponding type (e.g. "Fold Axis" and

"Foliation") directly in the Structures Toolbar:

Once selected, pressing Ctrl initiates addition of the selected combination. This mode is

well suited for logging a large number of the same structure type, as the same structure

type can repeatedly added by simply pressing Ctrl.

1. 

2. 
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Specific instructions for logging linear and, respectively, planar category structures follows

below.

Adding Linear Structures

Select the segment containing the structure you wish to log (see Selecting a Segment). For

example in this case, a stretching lineation:

1. 
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It's easiest to identify stretching lineations with the view direction orthogonal to the

structure direction (A):

To log a linear structure, begin by aligning the viewing direction of the view to the structure

direction (B). The linear structure should be shown as a point.

Initiate the addition of a linear structure type, through one of the two modes described

above.

If the type of structure you wish to add is not in the list, pick Other. You can later add a

comment describing the structure, which will be preserved when the structures are

exported (see Changing Structure Type and Comment below).

Using the left mouse button, click on the aligned linear structure in the 3D Tomography

view to add the structure:

2. 

3. 

4. 
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The linear structure is now added and represented by a thick line in 3D:

To abort an ongoing structure addition, linear or planar alike, simply press Escape on the

keyboard.

5. 

Tip
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Adding Planar Structures

Select the segment containing the structure you wish to log (see Selecting a Segment). For

example in this case, a cross-cutting shear zone within a quartz-feldspar matrix:

Align the viewing direction of the 3D Tomography view to the structure direction (as

above).

Initiate the addition of a planar structure type, through one of the two modes described

above.

If the type of structure you wish to add is not in the list, pick Other. You can later add a

comment describing the structure, which will be preserved when the structures are

exported (see Changing Structure Type and Comment below).

1. 

2. 

3. 
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Using the left mouse button, click on two points in the 3D Tomography view to add the

structure:

The structure is now added and represented by an elliptical disc in 3D:

The elliptical stretch of the disc increases with the acuteness of α (see Internal

Orientations in the Structure Orientations section), simulating the behavior of a physically

cut cross-section. Together with the dashed-line marker of the major axis, this helps to

visually gauge the "steepnees" of the structure w.r.t. the core axis.

4. 

5. 

Tip
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Removing Structures

Select the structure by clicking on its outline in the 3D Tomography view. The structure

outline will turn thicker to indicate that the structure is selected:

A description of the selected structure will also be shown in the status bar at the bottom,

including its depth and orientation angles. For an explanation of these angles, see the 

Structure Orientations section.

Press Delete on the keyboard to remove the selected structure.

If you have many structures to remove, it's more convenient to use the Structures Toolbox

available from Toolboxes → Structures in the menu bar. This will show a table of all

structures, where multiple structures can be selected using Shift/Control + Left Mouse

Button. Pressing the Remove button will remove all selected structures:

Changing Structure Type and Comment

Added structures can have an associated comment. If you want to change the type or

comment for a structure:

Bring up the Structures Toolbox using Toolboxes → Structures in the menu bar.

1. 

2. 

3. 

1. 
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Double-click a Type cell to bring up a drop-down to select the structure type:

If you want to describe a structure in more detail, you can double-click a Comment cell to

enter a free-text comment:

Confirm the change by pressing Enter or clicking outside the cell.

For information on how to export the logged structures to CSV (Comma Separated Values), see

Exporting Structures.

2. 

3. 
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Structures logged in Insight are by default described by (drill core) internal orientation angles.

Global orientation angles can further be produced and exported when a hole orientation (collar

data, see below) is set by the user.

All presented structure orientations are subject to a large number of possible error sources in

the underlying drilling, transport and scanning processes. Particular error sources associated

with the GeoCore X10 scanning process are therefore emphasized below.

Caution



Skip to content

Error source: All orientation angles except for α and γ are ill-defined if the sample was not

oriented during scanning. Always proceed with caution when interpreting structural

orientations.

You can verify that your sample was oriented during scanning by picking Show → Orientation

Marks from the menu bar:

A red line representing the orientation mark will be shown in the Preview and 3D Tomography

view for segments of core that have orientation information:

Caution
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The drill core internal orientation of linear and planar structures are each described by two

angles: α and β (planar structures) or γ and δ (linear structures).

Planar Structures

Planar structure angles are defined with respect to the major of axis of the intersection ellipse

that forms between the plane of the structure and the drill core surface.

The α angle (0-90°) is the acute angle between the core axis and the major axis.

The β angle (0-360°) is the angle from the orientation line to the down-hole end of the

major axis (the "apical trace"), measured positively around the down-hole core axis (i.e.

clockwise in a plane orthogonal to the core axis, while looking in the drilling direction).

Linear Structures

Linear structure angles are defined with respect to the linear direction, translated to pass

through the drill core axis.

The γ angle (0-90°) is the acute angle between the core axis and the linear direction.

• 

• 

• 
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The δ angle (0-360°) is the angle from the orientation line to the down-hole end of the

linear direction (the "apical trace"), measured positively around the down-hole core axis (i.e.

clockwise in a plane orthogonal to the core axis, while looking in the drilling direction).

Error source: The sample axis of the scan is currently used as an estimate for the true drill core

axis. Particular care should therefore be exercised for samples of low structural integrity and

when loading samples into the sample tube.

Global Orientations

To convert the internal orientation angles into a global orientation, the user must supply an

orientation of the hole in form of hole collar data (optionally extended with down-hole survey

data).

Collar Data

Collar data is set as a hole property using either Hole → Properties... in the menu bar or the Edit

Hole Properties button in the structure manager:

• 

Caution
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First enable collar data:

Then enter the hole orientation:

The user must here supply the following four values:

The Azimuth (0-360°) denotes the direction of the horizontal projection of the hole

trajectory, measured as a clockwise angle from the north (as seen from "above" on e.g. a

map).

The Inclination (0-90°) denotes the acute angle between the hole trajectory and the

horizontal plane. The angle will per default be assumed to measure below the horizontal

plane.

Top-of-hole marker (true or false) denotes that the orientation line of the hole has been

marked along the top (i.e. the "roof"). It is otherwise oppositely assumed that the

orientation line has been marked along the bottom (i.e. the "floor").

• 

• 

• 
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Upwards inclination (true or false) denotes that the inclination (in contrast to the default

assumption) measures above the horizontal plane. When shown to the user or exported,

this will be represented as a negative inclination value.

Error source: Both the azimuth and top-of-hole marker values are ill-defined for the case of

vertical holes (i.e. inclination ≈ ± 90°). As convention, the azimuth will then instead be assumed

to denote the direction in which a top-of-hole orientation line would be marked for a downwards

inclined hole.

The global orientations will be given in the same coordinate system as for which the user

supplied the collar data. "North" could for instance indicate geographical north, magnetic north,

or any other direction preferred by the user.

The global orientation of each structure is now shown as two angles: Dip and Direction (planar

structures), Plunge and Trend (linear structures):

Down-hole survey

For an improved description of the hole orientation, the Azimuth and Inclination values may

instead be provided as depth-dependent quantities by importation of down-hole survey data.

Insight allows import of down-hole survey data in CSV (Comma Separated Values) format.

Enable down-hole survey data and click Load, then use the dialog to locate your CSV file:

• 

Caution

Tip



Skip to content

Once the file has been loaded, select the appropriate columns to use as data:

The currently imported down-hole survey file is shown in the Hole Properties dialog:

An enabled down-hole survey overrides the manually entered Azimuth and Inclination values,

whereas Top-of-hole marker and Upwards inclination still applies as before.

To determine Azimuth and Inclination for arbitrary depths, Insight uses a linear interpolation

between the data points of the survey; for points that are outside of the surveyed depth range,

the hole is assumed to continue in a straight segment from the closest point.
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It is the user's responsibility to ensure a consistent and appropriate sign convention of 

Inclination values between the down-hole survey data file and it's usage in Insight, through

careful inspection of the data and adjustment of the Upwards inclination value.

Planar Structures

With the upwards inclined normal of the structure as reference direction for planar structures,

the global orientation angles are defined as:

Dip (0-90°): the acute angle between the reference direction and the upwards axis (equal to

the greatest slope of the plane).

Direction (0-360°): the horizontal projection of the reference direction, measured as a

clockwise angle from the north (as seen from "above" on e.g. a map).

Linear Structures

Similarly, with the downwards inclined direction of the structure as reference for linear

structures, the global orientation angles are defined as:

Plunge (0-90°): the acute angle between the reference direction and the horizontal plane.

Trend (0-360°): the horizontal projection of the reference direction, measured as a

clockwise angle from the north (as seen from "above" on e.g. a map).

Caution

• 

• 

• 

• 
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When dealing with a large number of logged structures, it is often desirable to get a

comprehensible overview of their orientations.

The Stereonet plot provides this functionality, by projecting the three-dimensional global

orientation of both linear and planar structures unto a two-dimensional canvas.

The Stereonet plot and it's options are only avilable for holes with collar data. See Collar Data

for more information.

Error source: All global orientation angles are ill-defined if the sample was not oriented during

scanning. Always proceed with caution when interpreting structural orientations.

Stereonet Plot

The Stereonet plot is available as a tab nex to 3D Tomography and Concentrations Map:

Note

Caution
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Each plotted data point corresponds to one of the user-logged structures, with a position

derived from it's Global Orientation.

Data Point Projections

The Stereonet plot in Insight employs a "pole" representation of structures with a lower

hemisphere perspective, meaning that:

Data point positions for linear structures are determined from their downwards-inclined

direction vectors (just like their global orientations).

Data point positions for planar structures are determined by their downwards-inclined

normal vectors (in contrast to their global orientations).

To visually separate between linear and planar structures, the former are plotted with dots

whereas the latter are plotted with squares.

• 

• 

Tip
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These reference directions are then projected unto the two-dimensional canvas through either

of two available projection techniques [Snyder, J. P. (1987). Map projections--A working manual

(Vol. 1395). US Government Printing Office. Page 154 and 182]:

Equal Angle (also commonly referred to as "stereonet" or "Wulff net")

Equal Area (also commonly referred to as "Lambert azimuthal" or "Schmidt net")

The difference between the two techniques is illustrated in detail by comparing their resulting

grid lines:

Selecting Structures

By default, all of the logged structures for the current hole will be shown in the plot, but there

are several ways to create a customized selection.

Firstly, the type of structures to be shown can be adjusted through the checkboxes found in the

menu to the right, allowing individual types or entire categories to be filtered away:

• 

• 
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Secondly, structures from a limited depth range can be selected by Selecting a Segment in the 

Preview area:

The selection is unset by clearing the segment selection in the Preview area.
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In addition to the manual structure logging offered in Insight (see Logging Structures), the

GeoCore X10 analysis also attempts to automatically identify several structural aspects of the

scanned core. This section describes the data sets that are currently offered, and how to use

them.

The data sets presented in this section constitute automated predictions based on custom-

tailored algorithms, with performance that may vary depending on factors such as the quality of

the scanned core and heterogeneities in the scanned material. While the predictions may often

constitute a good starting point, or even an accurate result, it is ultimately up to the expert user

to vet (or correct) them.

Core Axes

While the core axis and the scanning tube axis should to good approximation align for full-core

material of high quality, it is not necessarily the case for e.g. half-core or rubbly material. The

GeoCore X10 therefore identifies the core axes of rock pieces which can be fitted as cylinders

or half cylinders.

Identified core axes can be shown in the Preview area, by selecting Show → Core Axes from the

menu bar.

The axes of identified core pieces are shown as green full lines, whereas depth ranges that lack

identifed core pieces are shown by red dashed lines through the cylindrical axis of the scanned

sample:

Caution
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Joints

In connection to the rock pieces and core axes, several types of structures related to geological

joints are predicted.

To import automated structure predictions, click Import... in the Structures Toolbox to bring up

up a dialog with import options:
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Top faces and Bottom faces denotes planar fits to the top and bottom faces of the core pieces

with identified core axes.

Hidden joints, as the name suggests, denotes possible joints that were not identified in the

core axes prediction, i.e. joints that divide a single identified core axis into several axes. This

may for instance result from accurate puzzling together of well-fitting pieces in the scanning

tube, which makes it difficult to separate the pieces from each other in the tomopgraphic 3D

image.

The image illustrates one example for each type of auto predicted structure:

Once imported, a comment is appended to each structure, to set it apart from the manually

logged structures:
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Results from the scan data, as well as manual annotations made in Insight, can be exported to

CSV (Comma Separated Values) format files. Separate exports are available for:

Mass, density and element concentrations

Core log categories and entries

Linear and planar structures

Exporting Mass, Density and Concentrations

To export mass, density and element concentrations for the active hole, choose Hole → Export

Data... in the menu bar:

The Export Element Concentrations window will appear, where you can pick the export file

name, what elements to export and choose some export parameters. You can also choose the

grouping type, which is either 8 mm (highest granularity) or one row per interval (see Intervals).

• 

• 

• 
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Choose OK to confirm the export. If you checked the Open exported file when finished, the

resulting CSV will be opened using the application associated with CSV ( .csv ) files, for

example Excel.

The output format is a CSV with the following columns:

Hole ID  - Hole ID as text.

Depth From  - From depth in meters.

Depth To  - To depth in meters.

Volume  (Measured) - Measured volume of rock in cm³.

Volume Error  (Measured) - Measured volume error estimate in cm³. Since the volume is

measured by thresholding of the 3D tomography, which is a regular grid of finite-sized

voxels, the volume error is estimated as the volume of the single-voxel thick surface layer

which cannot be reliably classified as air or rock. Currently this is done under the

assumption of perfectly cylindrical (intact) core.

Mass  (Measured) - Measured rock mass in grams. This is measured per loaded sample

using the load cell in the GeoCore X10. See note below.

Mass Error  (Measured) - Measured rock mass error estimate in grams. Since the sample

is weighed on the load cell while inside the sample holder (tube), this error estimate

incorporates both the load cell's limited precision and the expected variation in sample

holder weight, which is subtracted from the measured weight to produce the rock mass.

Density  (Measured) - Measured density in g/cm³. See note below.

Density Error  (Measured) - Measured density error estimate in g/cm³. This is calculated

from the measured mass and measured volume error estimates.

XRF Degraded  - "Yes" if the XRF signals are degraded, otherwise "No" (see Degraded XRF

Signals).

Mass  (Estimated) - Estimated rock mass in grams.

Density  (Estimated) - Estimated density in g/cm³. This density is calculated from the

estimated mass and the measured volume.

Next follows one column for each exported element, containing the concentration in gram

per metric ton, with the chemical symbol as column heading. The columns are in

alphabetical order. (See Element Concentrations for information about which elements this

includes.)

In sections where the XRF signals are degraded, the Mass  (Estimated), Density  (Estimated)

and element concentration columns will be empty.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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Since there is only one measured mass value available per scanned sample, the measured

mass/density columns and their associated error columns are only present if the One row per

interval option is used, and a row will only have a value in these columns if both interval

boundaries coincide with the boundary of a scanned sample (see Intervals)

See Rock Density for information about the difference between measured and estimated

density.

Exporting Core Log

To export the core log of the currently active hole (see Core Logging), choose Hole → Export

Core Log... in the menu bar:

The Export Core Log window will appear, where you can pick the export file name, and which

log categories to include:

Choose OK to confirm the export. If you checked the Open exported file when finished, the

resulting CSV will be opened using the application associated with CSV ( .csv ) files.

Note



Skip to content

The result is a CSV file with the following columns:

Hole ID  - Hole ID as text.

From (m)  - Start depth in meters.

To (m)  - End depth in meters.

Next follows one column for each included log category, with the name of the category as

column heading. The rows below the header then contain the log entries of the category,

represented by the names of their associated log values.

The export consists of one data row per unique interval, as defined by the combined start and

end points of the log entries of all included log categories. I.e. each interval starts and ends, at

the closest pair of points that marks a change of log value in any of the included log

categories.

Exporting Structures

To export the structures you have logged in the active hole (see Logging Structures), choose 

Hole → Export Structures... in the menu bar:

The Export Structures window will appear, where you can pick the export file name, what

structure class to export and choose some export parameters:

• 

• 

• 

• 
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Choose OK to confirm the export. If you checked the Open exported file when finished, the

resulting CSV will be opened using the application associated with CSV ( .csv ) files.

The result is a CSV file with the following columns:

Hole ID  - Hole ID as text.

Class  - Linear or Planar

Type  - Structure type as text.

Depth  - Structure depth in meters.

Alpha  - α angle (0° to 90°) of planar structure in degrees.

Beta  - β angle (0° to 360°) of planar structure in degrees.

Gamma  - γ angle (0° to 90°) of linear structure in degrees.

Delta  - δ angle (0° to 360°) of linear structure in degrees.

Dip  - Dip angle (0° to 90°) of planar structure in degrees.

Dip Direction  - Direction angle (0° to 360°) of planar structure in degrees.

Plunge  - Plunge angle (0° to 90°) of linear structure in degrees.

Trend  - Trend angle (0° to 360°) of linear structure in degrees.

Hole Azimuth  - Azimuth angle (0° to 360°) of the hole collar in degrees.

Hole Inclination  - Inclination angle (-90° to 90°) of the hole collar in degrees.

Orientation Line Location  - Location ('Top' or 'bottom') of the orientation line marker.

Comment  - Optional text comment.

Please refer to Structure Orientations for definitions of the exported structure orientation and

hole collar variables.

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 



Skip to content

Scan Information

Meta data associated with each scan is available through the Scan Information window. Show

the window by selecting Hole → Scan Information... from the menu bar.

For each scan, the window shows information such as:

Scanner model/serial.

Scan and analysis software versions.

Temperature and humidity at the time of the scan.

Scanner calibration timestamps.

Input mineral list used for the mineralogical model fit.

Older versions of the scan software did not include all meta data in the scan result data. Some

of the meta data fields in the Scan Information window may be empty for scans made using

these older versions.

• 

• 

• 

• 

• 

Note
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The geochemical analysis of the GeoCore X10 combines X-ray Computed Tomography (XCT)

and X-ray Fluorescence (XRF) spectroscopy, through a mineralogical model fit that matches

simulated minerals to these observables. The quality of the model and its results are therefore

highly dependent on the suitability of the applied mineral list (see Element Concentrations and 

Scan Information) and how well it can be fitted to the physical contents of the scanned drill

core samples.

As a measure of the mineralogical model fit's performance, the Quality Control plot view,

available via Show → Quality Control (QC) in the menu bar, displays (rescaled) residual values

for the different types of measurement variables:

The residual for each observable is individually rescaled into a unity range (0 to 1), as

described below.
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A low (high) residual value is indicative of good (bad) performance, but cannot be taken as a

conclusive demonstration thereof, since there are many possible causes for variations in each

residual.

However, large residual values may often indicate that improved results could be obtained with

a better adapted mineral list, or point toward areas of different / unexpected mineralogy.

Alternatively, they may also indicate areas that are inherently difficult to model, such as material

which is too massive for accurate reconstruction with the XCT.

The residual values are only available for sections where the XRF signals are not degraded (see 

Degraded XRF Signals).

Mass Residual

The mass residual measures the difference between the estimated mass (modelled value),

obtained from tabulated densities combined with mineral mixture ratios from the mineralogical

fit, to the measured mass (observed value), as directly measured from the loadcell at scan

time.

The rescaled residual value scales linearly from exact agreement, to a mismatch which is equal

to (or greater than) 20 % of the measured mass.

Unlike the estimated density which is available in higher resolution (see Rock Density ), the

mass residual is only available as one value per sample, since there is only one measured mass

per sample.

XRF Residual

The XRF residual measures the difference in element specific XRF signals between the fitted

minerals (modelled value) and those obtained from the spectrometer(s) at scan time (observed

value). The modelled values are obtained from a lookup table, produced from Monte Carlo

simulations of electron and photon transport in ideal minerals, combined with the mineral

mixture ratios of the mineralogical fit. The observed values are obtained by fitting of spectral

Note

Note

Note
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profiles at element-specific energies, to the spectrometer readings subjected to background

substraction.

The rescaled residual value scales linearly from exact agreement, to a mismatch which is equal

to (or greater than) the 95th percentile of unscaled residuals, taken over all samples included in

Orexplore's internal reference library for analysis performance evaluation.

Note that the mineralogical fit in fact considers one signal per detectable element (see Element

Concentrations), but that the XRF residual, for comprehensibility, summarizes the them into a

single value, as a weighted sum over the squared signal differences.

The XRF residual is therefore an indicator of the overall performance for all detectable

elements, which does not necessarily reflect the performance for individual elements.

Note
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Customer Support

For troubleshooting and answers to common questions, please visit our support help desk at 

https://support.orexplore.com/.

https://support.orexplore.com/
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